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Document History

1 Note

Before you start the implementation, make sure you have the latest version of this document, which is

available at https://support.sap.com/sltoolset® | ¥ System Provisioning 3.

The following table provides an overview on the most important document changes:

Table 1:
Version Date Description
2.3 2017-02-06 Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)
2.2 2016-10-07
21 2016-06-06 Updated version for software provisioning manager 1.0 SP17 (SL Toolset 1.0 SP17)Up-
dated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18)
2.0 2016-02-15 Updated version for software provisioning manager 1.0 SP10 (SL Toolset 1.0 SP16):
Archive-Based Installation (see Preparing the Installation Media [page 30])
19 2015-10-12 Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP15)
18 2015-09-14 Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP14)
17 2015-04-27 Updated version for software provisioning manager 1.0 SPO8 (SL Toolset 1.0 SP13)
16 2014-11-24 Updated version for software provisioning manager 1.0 SPO7 (SL Toolset 1.0 SP12)
15 2014-07-07 Updated version for software provisioning manager 1.0 SP18 (SLUpdated version for
software provisioning manager 1.0 SPO6 (SL Toolset 1.0 SP11)
14 2014-03-17 Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP10)
1.3 2013-10-28 Updated version
12 2013-07-15 Updated version
11 2013-04-12 Updated version
1.0 2012-12-17 Initial version
Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
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1 Introduction

11 About this Document

This documentation describes how to install an SAP Web Dispatcher instance for SAP system products based
on SAP NetWeaver 7.1 and higher using the installation tool software provisioning manager 1.0 SP19
(“installer” for short), which is part of SL Toolset 1.0 SP19.

You can find a complete list of supported SAP system products in SAP Note 1680045 # .

We recommend that you use a Web Dispatcher [page 7] when you run an SAP system with several
application servers for web applications.

1.2 About Software Provisioning Manager

Software Provisioning Manager 1.0 is the successor of the product- and release-specific delivery of
provisioning tools, such as SAPinst. Before you run it, we recommend that you always download the latest
version of Software Provisioning Manager 1.0. Software Provisioning Manager 1.0 is part of the Software
Logistics Toolset 1.0 (“SL Toolset” for short). This way, you automatically get the latest fixes and supported
processes. For more information about Software Provisioning Manager as well as products and releases
supported by it, see SAP Note 1680045/ and http://scn.sap.com/docs/DOC-30236# . “SAPinst” has
therefore been renamed to “Software Provisioning Manager 1.0" in this documentation. However, the term
“SAPinst” is still used in:

e Texts and screen elements in the Software Provisioning Manager GUI
e Naming of executables, for example sapinst.exe

In the following, we generally refer to Software Provisioning Manager 1.0 as the “installer”. We only use the
term “Software Provisioning Manager 1.0" if this is required for technical reasons.

° Caution

SAP is going to restrict maintenance for operating system versions that have been initially released with
SAP kernel 7.2<x> but are no longer supported for SAP kernel 7.40 and higher. The following Software
Provisioning Manager operating system versions are affected:

o WINDOWS SERVER ON IA32 32BIT

o WINDOWS ON IA64

o WINDOWS ON X86_64 64BIT: < 6.0 aka Windows 2008

With the release of Software Provisioning Manager 1.0 SPS 18, the swpM* . SAR archive will stop working
on the above listed outdated operating system versions.

Instead of using the swpM* . SAR archive, you must use the RMOSSWPM* . SAR archive for these outdated
operating system versions.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Keep in mind that the RMOSSwWPM* . SAR archive will not receive improvements in the future. SAP
maintenance for RMOSSWPM* . SAR will be finally stopped by the end of 2017.

SAP recommends upgrading the operating system to a more recent version and using RMOSSWPM* . SAR
to export from existing SAP systems.

Related Information

Preparing the Installation Media [page 30]

1.3 New Features

The table below provides an overview of the new features in Software Provisioning Manager.

Make sure that you also read the release notes for your SAP product at http://help.sap.com | # <Product

Area> » <Product> p <Release> p What's New — Release Notes J.

Table 2:
Feature

Verification of Integ-
rity of Data Units in
Software Provision-
ing Manager

Description

The integrity of data units extracted from the Software Provision-
ing Manager archive is verified. For more information, see Down-
loading the Software Provisioning Manager Archive [page 31].

In addition, check SAP Note 1680045#% whether additional in-
formation is available.

Availability

Software Provisioning Manager
1.0 SP19 (SL Toolset 1.0 SP19)

Installation without
Message Server
Port Configuration

Configuration of message server host and port during the instal-
lation is now optional. For more information, see Basic Installa-
tion Parameters [page 18].

Software Provisioning Manager
1.0 SP19 (SL Toolset 1.0 SP19)

WEBDISPATCHER. S
AR Archive for Ar-
chive-Based Instal-
lation

You can now use a specific WEBDISPATCHER . SAR archive instead
of the SAPEXE . SAR archive.

For more information, see Downloading Specific Installation Ar-
chives (Archive-Based Installation) [page 33]

Software Provisioning Manager
1.0 SP18 (SL Toolset 1.0 SP18)

Archive-Based In-
stallation

You can now download the required installation archives instead
of the complete SAP kernel installation media. For more informa-
tion, see Downloading Specific Installation Archives (Archive-
Based Installation) [page 33].

Software Provisioning Manager
1.0 SP10 (SL Toolset 1.0 SP16)
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Feature

System Provision-
ing for SAP
NetWeaver 7.5 and
SAP NetWeaver 7.5-
based Products

Description

All system provisioning tasks (installation, system copy, system
rename) are available for the new SAP NetWeaver 7.5 release.

The Dual Stack option, which integrates an AS ABAP and AS Java
in a single system (common System ID <sAPSID>, common
startup framework, common database), is no longer supported in
SAP systems based on SAP NetWeaver 7.5.

AVETIE 11 113%

Software Provisioning Manager
1.0 SPO9 (SL Toolset 1.0 SP15)

Feedback Evalua-
tion Form

SAP SE's aim is to provide fast and efficient procedures. To eval-
uate the procedure you just carried out, we need information gen-
erated by the tool during process execution and your experience
with the tool itself. A new evaluation form contains a simple ques-
tionnaire and XML data generated during the procedure.

Port 4239 is used for displaying the feedback evaluation form.
For more information, see the Prerequisites section in Running
the Installer [page 36].

Software Provisioning Manager
1.0 SPO7 (SL Toolset 1.0 SP12)

Option Verify Signed
Media

The digital signature ensures that the signatory of a digital docu-
ment can be identified unambiguously and signatory's name is
documented together with the signed document, the date, and
the time.

For more information, see SAP Note 1979965 ¥ .

Software Provisioning Manager
1.0 SPO6 (SL Toolset 1.0 SP11)

1.4 Architecture and Functions of the SAP Web Dispatcher

The SAP Web Dispatcher is located between the Web client (browser) and your SAP system that is running the

Web application.
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Figure 1: SAP Web Dispatcher in the System Landscape

It forwards the incoming requests (HTTP, HTTPS) in turn to the application server (AS) of the SAP system.
The number of requests that are sent to an AS depends on its capacity. The capacity of an AS ABAP depends
on the number of configured dialog work processes. The capacity of a AS Java depends on the number of
server processes. If the application is stateful, the SAP Web Dispatcher ensures that with the next request, the
user is forwarded to the server that is processing his or her application. To do this, it uses the session cookie
with HTTP connections, and the client IP address with end-to-end SSL.

Furthermore, the SAP Web Dispatcher decides whether the incoming request should be forwarded to an ABAP
or Java Server.

1 Note

Unlike HTTP load balancing with the SAP Message Server, redirects are not executed when the SAP Web
Dispatcher is used. This avoids the associated disadvantages (several IP addresses must be known, book
marking is not possible, authentication after changing the application server).

SAP Web Dispatcher for Multiple Systems

In the figure the SAP Web Dispatcher is located in front of an SAP system.

You can also place the SAP Web Dispatcher in front of multiple systems (SAP and/or external systems). In this
case use parameter wdisp/system  <xx>to inform the SAP Web Dispatcher of all the systems and their
message servers.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Structure of the SAP Web Dispatcher

The architecture is the same as the architecture of the Internet Communication Manager (ICM). The SAP Web
Dispatcher uses the same HTTP framework and is likewise structured modularly from subhandlers. But unlike
the ICM, the SAP Web Dispatcher does not directly pass incoming requests to a work process (such as a
server process)— it passes them to the ICM of the application server. The response of the application server to
a request returns to the client using the same network connection via the SAP Web Dispatcher.

If the application server acting as the client opens connections to external HTTP servers, these connections go
direct to the server (or possibly via a configured proxy) and not via the SAP Web Dispatcher.

The Web Dispatcher has the function of a “reverse proxy”, and not that of a “proxy”.

Processing HTTP Requests

Like the ICM the SAP Web Dispatcher uses various handlers to process incoming requests. With the exception
of the ABAP handler and the Java handler the handlers are called in the precise sequence described in
"Processing HTTP Requests". The dispatching handler comes last and this performs the load balancing and
then forwards the request to the ICM of the appropriate application server.

Information Tables

The SAP Web Dispatcher gets information about the SAP system that it needs for load distribution from the
message server and application server via HTTP.

1 Note

With Java-only installations of the SAP NetWeaver AS the message server of the “Central Services” (SCS)
supplies the information. With ABAP installations the information comes from the message server of the AS
ABAP. The SAP Web Dispatcher knows which message server is used from the parameters rdisp/mshost
andms/http port orwdisp/system <xx>.

You can also use HTTPS here. The SAP Web Dispatcher keeps the information in the following tables:

Table 3:
Information Source of Information
Server table All AS instances that process the Message server of the SAP system with the server
HTTP(S) requests. list.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Table Information Source of Information

Group table Groups of HTTPS-enabled ABAP servers. | You maintain logon groups in transaction sMLG in
Here there are known logon groups that | AS ABAP. The SAP Web Dispatcher can get the in-
are maintained in the system, as well as | formation from any AS ABAP.
the following internal groups: o

Each application server belongs to at least two of
the internal groups. Each server can also offer
ABAP and Java and hence belong to all groups.
You can also configure logon groups for AS Java.

IALL Group of all connected application serv-
ers.

1J2EE Group of those application servers that
contain the AS Java.

IDIAG Group of ABAP servers that provide the
dialog work processes.

1J2EES Group of HTTPS-enabled application
servers that contain the AS Java.

IDIAGS Group of HTTP-enabled servers that pro-
vide the dialog work processes.

URL mapping table Mapping of the path part that is specified | You maintain the URL path in transaction SICFin
in the browser to the information about | AS ABAP as a service in the HTTP service tree.
the server (groups). ) ) )

The SAP Web Dispatcher can get the information
from any AS.
Example Y

You can determine, for example, that

all requests that contain the path pre-

fix /sap/bcare only processed by the

servers that process logon group

GROUP_1.

More Information

For more information, see the Web Dispatcher documentation in the SAP Library [page 11] at: [ Function-

Oriented View ¥ Application Server Infrastructure » Components of SAP NetWeaver Application Server » SAP

Web Dispatcher J
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1.5 SAP Notes for the Installation

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most
recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note which you can find in the SAP Service
Marketplace at http://service.sap.com/notes?.

Table 4: SAP Notes for the Installation

SAP Note Number Title Description
1680045 P Release Note for Software Provisioning Remarks, annotations, and corrections
Manager 1.0 discovered after publication of the docu-
mentation Software Provisioning Manager
908097 #r SAP Web Dispatcher: Release, Installa- Contains information about the following:

tion, Patches, Documentation e How to apply patches to an existing

Web Dispatcher installation

e \Which Web Dispatcher release you
can use with which SAP NetWeaver
release

1.6 Accessing the SAP Library

The references to SAP NetWeaver Library documentation in this installation guide always refer to the
following on SAP Help Portal:

Table 5:

Product and Release ‘ SAP Library Path

SAP systems based on SAP NetWeaver 7.3 http://help.sap.com/nw73|[F Application Help # Function-Oriented View:

English 3

SAP systems based on SAP NetWeaver 7.3 in-
cluding Enhancement Package 1

http://help.sap.com/nw731|} Application Help > Function-Oriented
View: English |

SAP systems based on SAP NetWeaver 7.4 |y / /help sap.com/nw74|p Application Help % Function-Oriented View:

English 4

SAP systems based on SAP NetWeaver 7.5 http://help.sap.com/nw75|} Application Help » Function-Oriented View:

English ]

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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1.7 Naming Conventions

In this documentation, the following naming conventions apply:

1 Note

From a technical point of view, the web dispatcher is set up like an SAP system with its own SAP system ID
(SAPSID), its own operating system users, and its own directory structure.

e nstaller refers to software provisioning manager 1.0.
® SAP system refers to web dispatcher .
e jnstance refers to a web dispatcher Instance.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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2 Planning

2.1 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the
Web Dispatcher.

Caution

If your hosts do not fully meet the requirements, you might experience problems when working with the
SAP system.

Process Flow

1. Check the Product Availability Matrix at http://service.sap.com/pam# for supported operating system
releases.

2. If you want to use the Web Dispatcher for a production system, the values provided by the Prerequisite
Checker and the hardware and software requirements checklists are not sufficient. In addition, do the
following:

o You use the hardware sizing information available at http://service.sap.com/sizingfr.
For the Web Dispatcher, there is a sizing guideline available at:
http://service.sap.com/sizing®& | Sizing Guidelines ¥ Solutions & Platform » Sizing the SAP Web
Dispatcher J
© You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing
depending on:
o The set of applications to be deployed
© How intensively the applications are to be used
©  The number of users

2.1.1 Hardware and Software Requirements Tables

The Web Dispatcher host must meet the following requirements:

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Table 7: Hardware Requirements

Hardware Re- Requirement How to Check
quirement

Minimum disk e 1GB of hard disk space minimum for the installation as such. To check disk space:
space For production use, you need to reserve at least 5 GB.

e Windows Server 2012
e Temporary disk space for every required installation medium that (R2):

you have to copy to a local hard disk:

1. Open Power-
4.3GB

Shell in elevated
mode, and enter
the following
command:
get-volume

2. Checkthe value
SizeRemaining
of the disk you
want to install
on.

e Windows Server

2008 (R2):
1. Choose |} Start
> Al Programs
» Administrative

Tools > Storage
> Computer
Management >
Disk
Management p |
2. Right-click the

drive and choose
Properties.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Hardware Re- Requirement How to Check
quirement
Minimum RAM The SAP Web Dispatcher instance requires 1 GB RAM minimum. For To check RAM:
memory consumption in productive use, see SAP Note 2007212 Fr . e Windows Server 2012
(R2):

Open PowerShell in
elevated mode, and
enter the following
command:
Get-WmiObject
Win32 Computer
System

e Windows Server
2008 (R2):

Choose |} Start >
Control Panel »
System 4.

1 Note

If System is not
visible, change
View by: from
Category into
Large icons.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Hardware Re- Requirement How to Check
quirement
Paging file size For more information, see SAP Note 1518419#% . To check paging file size:
e Windows Server 2012
(R2):

For more informa-
tion, see Checking
and Changing the
Paging File Settings
on Windows Server
2012 (R2) [page 50]
e Windows Server

2008 (R2):

1. Choosell Start
> Control Panel

> System }

1 Note

If Systemis
not visible,
change View
by: from
Category into
Large icons.

2. Choose
Advanced
system settings.

3. Insection
Performance, se-

lect | Settings...

» Advanced 3.
4. Ifrequired, in
section Virtual
memory, choose
Change.

1 Note

Do not select
Automatically
managed
paging file
size for all
drives.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Hardware Re- Requirement How to Check

quirement

Processing units The number of physical or virtual processing units usable by the operat-
ing system image must be equal to or greater than 2.

Examples of processing units are processor cores or hardware threads
(multithreading).

In a virtualized environment, ensure that adequate processor resources
are available to support the workloads of the running SAP systems.

Suitable backup
system

Table 8: Software Requirements

Software Requirement | Requirement How to Check

Windows operating sys- | ® 64-bit version of one of the following Win- | To check your Windows version:
tem dows Server Editions:

o Windows Server 2012 (R2):

o Windows Server Standard Edition

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and
enter the following command:

o Windows Server Datacenter Edi- Get-WmiObject
tion Win32 OperatingSystem |
© o Windows Server Standard Edition select caption

©  Windows Server Enterprise Edition | o  \windows Server 2008 (R2):

o Windows Server Datacenter Edi-

; 1. Choose |» Start * All Programs
ion

o Windows Server 2008 (R2) for Ita-
nium-Based Systems Edition

Accessories > Command Prompt 1

2. Enter the command winver

A Caution

For up-to-date information on the re-
leased and supported operating system
versions for your SAP product and data-
base, see the Product Availability Matrix
(PAM) at http://support.sap.com/pam
L

A Caution

Make sure that you install the English
language pack so that your support re-
quests can be handled quickly.

e Forany version of Windows Server, you
need the latest supported service pack

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
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Software Requirement

Requirement

Windows regional set- English (United States) must be set by default. Choose |’ Start > Control Panel > Clock
tings For more information about localized Windows

versions, see SAP Note 362379 .

You can install additional languages but the de-
fault setting for new users must always be
English (United States).

How to Check

Language, and Region > Language 3

2.2 Basic Installation Parameters

The table below lists the basic input parameters that are prompted by the installer. For all other SAP system
parameters, use the F1 help in the installer screens.

Table 9:

Parameters

Description

SAP System ID <saAPSID>

The SAP System ID <saps1D> identifies the whole SAP system.

A Caution

Choose your SAP system ID carefully. You cannot change the SAP system ID after
the installation.

Make sure that your SAP system ID:

® |sunique throughout your organization
e (Consists of exactly three alphanumeric characters
e (Contains only uppercase letters

e Has a letter for the first character

e Does not include any of the reserved IDs listed in SAP Note 1979280 #r .

Instance Number for the SAP Web
Dispatcher

Instance Number:

Technical identifier for internal processes. Consists of a two-digit number from 00 to
97. The instance number must be unique on a host. That is, if more than one SAP in-
stance is running on the same host, these instances must be assigned different num-
bers.

/A Caution

Do not use 43, 60, 89 for the instance number of the SAP Web Dispatcher.

18 CUSTOMER
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Parameters

Virtual Host Name

Description

Virtual host name (network name) of the SAP<SAPSID> cluster group

If you provide a virtual host name in the <Instance Name> Virtual Host field of the
screen of an instance, this instance is installed with the given virtual host name. After
the installation has completed, all application servers can use this virtual host name to
connect to the instance. The virtual host name is also a global host name. If you do not
provide the virtual host name, the instance is installed automatically using its physical
host name.

You must have already reserved the virtual host name (network name) and its IP ad-
dress on a DNS server before you run the installer. For more information, see Using
Virtual Host Names [page 29].

1 Note
Fully qualified host names, 1Pv4, IPv6 are not accepted as virtual host names.
Alternatively you can assign virtual host names also by starting the installer with the

SAPINST USE HOSTNAME property. For more information, see Running the Installer
[page 36].

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
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Parameters

Operating System Users

Description

The passwords of the operating system users must comply with the Windows pass-
word policy. The installer processes the passwords of operating system users as fol-
lows:

e |f the operating system users do not exist, SAP creates the following users:
O <sapsid>adm
This user is the SAP system administrator user. It is a member of the local
Administrators group.
O SAPService<SAPSID>
This user is the Windows account to run the SAP system. It is not a member
of the local Administrators group.
O sapadm
The host agent user sapadm is used for central monitoring services. The in-
staller creates this user by default as a local user although it is not a member
of the local Administrators group.
If required, you can change this user to become a domain user on the param-
eter summary screen. For more information, see Performing a Domain In-
stallation Without Being a Domain Administrator [page 24]. For security
reasons, however, SAP strongly recommends you to create this user as a lo-
cal user.
The installer sets the master password for these users by default. You can over-
write and change the passwords either by using the parameter mode Custom or
by changing them on the parameter summary screen.
e |fthe operating system users already exist, the installer prompts you for the exist-
ing password, except the password of these users is the same as the master
password.

Caution

Make sure that you have the required user authorization [page 23] for these ac-
counts before you start the installation.

Message Server Host

You can configure the SAP Web Dispatcher to connect to an SAP system immediately
during the installation by defining the host on which the message server is located
(profile parameter MSHOST).

However, you can also specify to not configure the message server host and configure
it manually after the installation has completed.

Message Server HTTP(S) Port

You can configure the SAP Web Dispatcher to connect to an SAP system immediately
during the installation by defining the HTTP(S) port of the message server (profile pa-
rameter MSPORT <XX>).

However, you can also specify to not configure the HTTP(S) port of the message
server and configure it manually after the installation has completed.
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Parameters

SAP Web Dispatcher Configura-
tion

Description

® You can specify a maximum of incoming concurrent connections
This value is directly mapped to the tuning parameter icm/max_conn. For more
information, see SAP Note 2007212 .

e HTTPS port:
The HTTPS port of the SAP Web Dispatcher is an entry point to the SAP system.
The defaultis 44 3<XX>(where <XX> is the instance number).

e HTTP port:
Optionally you can change the HTTP port number if the port number assigned by
default does not suit your needs.
The HTTP port of the SAP Web Dispatcher is an entry point to the SAP system.
The default is 80<XX> (where <XX> is the instance number).
You can either accept a default value for the HTTP port number or configure the
port number as required.

= Recommendation

If you want to install SAP Web Dispatcher version 7.21, we recommend that
you choose the HTTP port, because the HTTPS port is not available after the
installation without further configuration.

For more information about port configuration for SAP Web Dispatcher, see the SAP
Library [page 11] at: |} Application Server > Application Server Infrastructure >
Components of SAP NetWeaver Application Server } SAP Web Dispatcher >
Administration of the SAP Web Dispatcher > Configuration of the SAP Web Dispatcher
Server Port 4

Encryption Mode

The Encryption Mode defines the encryption for communication between the SAP
Web Dispatcher and the back-end system. You can choose between one of the follow-
ing options:

e Always: HTTPS is used.

e Never: HTTP is used.

® |Depending on the incoming protocol:

HTTPS is used for requests to the SAP Web Dispatcher HTTPS port, whereas
HTTP is used for requests to the SAP Web Dispatcher HTTP port.

The profile parameter responsible for the encryption mode is named
SSL_ENCRYPTION.

Activate ICF nodes

The SAP Web Dispatcher uses ICF services of SAP ABAP system's application servers
to retrieve information about server groups and URL mappings. By default, all ICF

services are inactive. For more information, see SAP Note 552286 ¥ .
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3 Preparation

3.1 Checking the Windows File System

Use

You need to check that you are using the Windows file system NTFS on hosts where you want to install the
SAP system and database. NTFS supports full Windows security and long file names.

1 Note

You must use NTFS for an SAP system installation. Do not install the SAP directories on a FAT partition.

Procedure

1. Open the Windows Explorer.
2. Select the relevant disk.

3. Choose |+ Properties » General .
The system displays the type of file system in use.

4. Check that the file system is NTFS.

3.2 Reducing the Size of the File Cache

Use

1 Note
This step is not required if you use Windows Server 2008.

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the
file cache as described below.
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Procedure

1. Choosellr Start » Control Panel » Network Connections  Local Area Connections 3.
2. Inthe Local Area Connection Status dialog box, choose Properties.

3. Inthe Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft
Networks.

4. Select Maximize data throughput for network applications.

Caution

If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been
installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose OK.

3.3 Required User Authorization for Running the Installer

Although the installer automatically grants the rights required for the installation to the user account used for
the installation, you have to check whether this account has the required authorization to perform the
installation. The authorization required depends on whether you intend to perform a domain or local
installation. If necessary, you have to ask the system administrator to grant the account the necessary
authorization before you start the installation. If you attempt the installation with an account that does not
have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

Procedure

Caution

Do not use the user <sapsid>adm for the installation of the SAP system.

Domain Installation

For a domain installation the account used for the installation needs to be a member of the local
Administrators and the domain Admins group of the relevant domain. All machines in the system must
belong to the same domain. In a domain installation, the user information is stored centrally on the domain
controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to
perform a domain installation to avoid authorization problems.

For a domain installation, you need to:
1. Check that the account used for the installation is a member of the domain Admins group.
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2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of
the domain Admins group.

Local Installation

For a local installation the account used for the installation needs to be a member of the local
Administrators group of the machine involved. In a local installation, all Windows account information is
stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

Caution

Do not use the Windows built-in account Administrator or the renamed built-in account to install your
SAP system. The built-in account only has restricted network access rights that are required by the
installer. If you renamed the built-in account Administrator, do not create a new account named

Administrator.

For alocal installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.

2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of
the local Administrators group.

3.4 Performing a Domain Installation Without Being a
Domain Administrator

You normally perform a domain installation of the SAP system with a user who is a member of the domain
Admins group, as described in Required User Authorization for Running the Installer [page 23]. If for any
reason, the account used for the installation is not a member of the domain Admins group, you can perform
the installation with a domain user who is a member of the local Administrators group. In this case, the
domain administrator has to prepare the system appropriately for you. The domain administrator can perform
the following steps either using the installer or manually:

1. Create the new global group SAP_<SAPSID> GlobalAdmin.
2. Create the two new SAP system users <sapsid>admand SAPService<SAPSID>.

3. Addthe users <sapsid>admand SAPService<SAPSID> to the newly created group
SAP_<SAPSID> GlobalAdmin.

1 Note

The installer creates the operating system user for the SAP Host Agent by default as a local user that is not
a member of the local Administrators group. If you want to create this user manually as a domain user,
you must perform the following steps:

Creating the SAP Host Agent User and Group Manually

However, for security reasons we strongly recommend you to create this user as a local user.
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Prerequisites

® You must be domain administrator to perform the required steps.

e Windows Server 2008 (R2) and Windows Server 2012 (R2):
You must have installed the feature Remote Server Administration Tools as follows:

o Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
add-windowsfeature RSAT-ADDS

o Windows Server 2008 (R2):
1. Choosel|p Start » Administrative Tools ¥ Server Manager 3.
2. Inthe Server Manager window, select Features.
3. Select the feature [ Remote Server Administration Tools  Role Administration Tools ¥ Active

Directory Domain Services Tools 3.

Procedure

Creating the Required Users and Groups Using the Installer

On the host where the SAP system is to be installed, the domain administrator starts the installer as described
in Running the Installer [page 36] and chooses ||» Generic Installation Options # <Database> ¥ Preparations

» Operating System Users and Groups 4 to have the group and users created automatically.

Creating the Required Users and Groups Manually

1 Note

To create the users and groups specific to the SAP Host Agent, you must follow the procedure below, and
replace the users and groups with those for the SAP Host Agent.

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

Perform the following steps:

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
net group SAP_<SAPSID> GlobalAdmin /add /domain

e \Windows Server 2008 (R2):
1. Logon as domain administrator.
2. Start the Active Directory Users and Computers Console by choosing:

|» Start » Control Panel » Administrative Tools ¥ Active Directory Users and Computers 3.

3. Right-click Users in Tree, and choose | New j» Group 3.
4. Enter the following:

Group name: SAP_<SAPSID> GlobalAdmin
5. Select the following:

1. Group scope: Global

2. Group type: Security
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6. Choose OK.
Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

Perform the following steps:

e Windows Server 2012 (R2):
1. Open PowerShell in elevated mode.
2. Create the <sapsid>adm user with the following command:
net user <sapsid>adm <Password> /add /domain
3. Create the sAPService<SAPSID> user with the following command:
net user SAPService<SAPSID> <Password> /add /domain
e Windows Server 2008 (R2):
1. InActive Directory Users and Computers Console, right-click Users in Tree and choose:
I New ¥ User 3
2. Enter the following:

Table 10:
Field Input for <sapsid>adm Input for SAPService<SAPSID>
First name: None None
Initials: None None
Last name: None None

3. Choose Next and enter the following:
Password: <Password>
Confirm password: <Password>

4. Select Password never expires.

1 Note

Make sure that no other options are selected.
5. Choose |l Next ¥ Finish 3.

Adding the Manually Created Users to Groups

1 Note

To add the users specific to the SAP Host Agent to the relevant groups, you must follow the procedure
below, and replace the users and groups with those for the SAP Host Agent.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
net group SAP_<SAPSID> GlobalAdmin <sapsid>adm /add /domain
e Windows Server 2008 (R2):
1. Inthe Users folder, double-click the newly created user account <sapsid>admin the list on the right.
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2. Choose|l Member » Add 2.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

1 Note

By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

e Windows Server 2012 (R2):
Open PowerShell in elevated mode, and enter the following command:
net group SAP_<SAPSID> GlobalAdmin SAPService<SAPSID> /add /domain

e Windows Server 2008 (R2):
1. Inthe Users folder, double-click the newly created user account SAPService<SAPSID> in the list on
the right.
Choose | Member » Add .
Select the new SAP_<SAPSID>_GlobalAdmin group.
Choose Add to add it to the list, and then OK.
Choose OK to close SAPService<SAPSID>Properties.
Close the Active Directory Users and Computers Management Console.

o0 s WD

3.5 SAP Directories

The installer automatically creates the directories listed in the following figures and tables. Before running the
installation, you have to set up the required file systems manually. In addition, you have to make sure that the
required disk space for the directories to be installed is available on the relevant hard disks. The figure below
assumes that you have set up one file system for the SAP system mount directory <sapmnt > and one file
system for the /usr/sap directory. However, you have to decide for which directories you want to set up
separate file systems. If you do not set up any file system on your installation host, the installer creates all
directories in the root directory /. The installer prompts you only for the <sapmnt> directory during the
installation.

Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on
Windows
Preparation CUSTOMER 27



Global Host

Local Instances

<Drive> <Drive> ~ o Local
| Access to Global | c[():?r!::itgri 5 : a
Directories
sap D \\<5APGL81‘?;“(':-H(3tﬁ)T>\SaPm"t sap D \\<SAPLOCALHOST>\saploc
pa UNC path
| \\<SAPLOCALHOST>\saploc (UNC path)
<SAPSID> (UNC path) <SAPSID>
SYS
W<No>
global
profile — work
exeI — log
uc/lnuc — data
<platform> — exe

—— — —p :Replication by sapcpe W<No> : SAP Web Dispatcher

i . Instance
uc/nuc : Unicode /7 non-Unicode On global host:

SAPGLOBALHOST = SAPLOCALHOST
Figure 2:

The directory of the SAP Web Dispatcher instance is W<Instance Number>, for example Ww00.

SAP File Directories in Detail

1 Note
The listed file system sizes are initial SAP requirements.

Depending on your operating system, you might also have to add space for administrative purposes.
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Table 11:
Directory Name Description ’ Space Required
<Drive>:\usr\sap \usr\sap is created and shared with the network share 500 MB
\<SAPSID> sapmnt.

The \usr\sap directory contains general SAP software, global

and local (instance-specific) data.

For this, the following directories are created in usr\sap
\<SAPSID>\SYS:

® global (contains globally shared data)

® profile (contains the profiles of the instance)

® cxe (contains executable kernel programs)

The directory usr\sap\<SAPSID>\<INSTANCE> is the direc-
tory of the instance:

The instance name (instance ID) of the Web Dispatcher instance
isW<Instance Number>,for example woo0.

<Drive>:\usr\sap \usr\sap\trans This value heavily depends

\t on the use of your SAP sys-
rans This directory contains SAP software for the transport of ob- N you y

jects between SAP systems . tem.
For the installation, it is suf-
ficient to use 200 MB for

each SAP system instance.
You can enlarge the file sys-

tem afterwards.

3.6 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide
their physical network identities from each other. This can be useful when quickly moving SAP servers or
complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

e Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

® Make sure that you configured the Windows operating system properly to use virtual host names. For
more information, see SAP Note 1564275 .
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Procedure

To install a non-high-availability system, proceed as described in SAP Note 1564275 .

3.7 Preparing the Installation Media

This section describes how to prepare the installation media.
Installation media are available as follows:

e The Software Provisioning Manager 1.0 archive containing the installer.
You always have to download the latest version of the Software Provisioning Manager 1.0 archive.

e The complete media or dedicated installation archives (SAR files) containing the software to be installed,
which are available as follows:

© You can use the physical installation media as part of the installation package as described in Using
the Physical Media from the Installation Package (see the Related Information section below).

o You download the complete installation media as described in Downloading the Complete Installation
Media (see the Related Information section below).

o Asan alternative to downloading the complete SAP kernel media, you can download the specific SAP
kernel archives (SAR files), as described in Downloading SAP Kernel Archives (Archive-Based
Installation) (see the Related Information section below).

For more information about which kernel version to use, see SAP Note 1680045¢% . In addition, check the
Product Availability Matrix at: http://support.sap.com/pam#e.

Related Information

Downloading the Software Provisioning Manager Archive [page 31]

Downloading the Complete Installation Media [page 34]

Using the Physical Media from the Installation Package [page 32]

Downloading Specific Installation Archives (Archive-Based Installation) [page 33]
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3.7.1 Downloading the Software Provisioning Manager
Archive

You always have to download and unpack the Software Provisioning Manager 1.0 archive
(SWPM10SP<Support Package Number> <Version Number>.SAR)from the SAP Software Download
Center because you must use the latest version.

Prerequisites

Make sure the latest version of the SAPCAR archiving tool is available on each installation host.

You require the SAPCAR archiving tool to be able to unpack software component archives (¥.SAR files), which
is the format of software lifecycle media and tools that you can download from the SAP Software Download
Center.

If required, you can download the latest version of SAPCAR from:
http://support.sap.com/swdcf | Software Downloads » SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) » S » SAPCAR 1.

For more information about SAPCAR, see SAP Note 212876 .

Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive
SWPM10SP<Support Package Number> <Version Number>.SARfrom:

http://support.sap.com/swdc# | Software Downloads » SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) ¥ S » SOFTWARE PROVISIONING MANAGER 3

1 Note

If you have an operating system version that has been initially released with SAP kernel 7.2<x> but is no
longer supported for SAP kernel 7.40 and higher, instead of the swpM* . SAR archive you must download
the RMOSSWPM* . SAR archive for these outdated operating system versions. For more information, see
About Software Provisioning Manager [page 5].

2. If you want to verify the signature of the
SWPM10SP<Support Package Number> <Version Number>.SAR archive, execute the following
commands :

1 Note
In addition, check SAP Note 1680045#% whether additional information is available.

<Path to SAPCAR>\sapcar.exe -tVvf<Path to Temporary Directory>
\SWPM10SP<Support_Package Number> <Version Number>.SAR
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3. Unpack the Software Provisioning Manager archive to a local directory using the following command:

<Path to SAPCAR>\sapcar.exe -xvf <Path to Temporary Directory>
\SWPM10SP<Support_Package Number> <Version Number>.SAR

1 Note

Make sure that all users have read permissions for the directory where you want to unpack the installer.

Caution

Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not
unpack it to the same folder as other installation media.

3.7.2 Using the Physical Media from the Installation Package

This section describes how you use the physical installation media as part of the installation package.

Procedure

1. Identify the required media for your installation as listed below.

Table 12:
Installation Media Description
Software Provisioning Manager 1.0 Software provisioning manager 1.0 archive

SWPM10SP<Support Package Number> <Version Number>.SAR

SAP Kernel Make sure that either the UC kernel or the NUC kernel software are
available, depending on the installation option you want to choose:

o Unicode (UC) Kernel if you want to install the SAP Web Dis-
patcher with kernel version 745 (installation option SAP Web
Dispatcher (Unicode)):

Folder K_<version> U <0S>where U means “Unicode”.

o Non-Unicode (NUC) Kernel if you want to install the SAP Web Dis-
patcher with kernel version 721 or 742 (installation option SAP
Web Dispatcher (Non-Unicode)):

Folder K _<version> N <0S>where N means “non-Unicode”.

2. Make the installation media available on the installation host as follows:
a. Download and unpack the latest version of Software Provisioning Manager as described in
Downloading the Software Provisioning Manager Archive [page 31].

b. Make the media containing the software to be installed available.
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You can do this in one of the following ways:

o Copy the required media folders directly to the installation host.
o Mount the media on a central media server that can be accessed from the installation hosts.

Caution

o |f you copy the media to disk, make sure that the paths to the destination location of the copied
media do not contain any blanks.

o If the user does not yet exist, you have to create the user manually before you install the SAP
system.

3.7.3 Downloading Specific Installation Archives (Archive-
Based Installation)

As an alternative to downloading the complete SAP Kernel media, you can also download exactly the
installation archives that are required for your installation.

Context

You must download - apart from the Software Provisioning Manager 1.0 archive which is always required for an
installation - the sapwebdisp <Version>.sar and SAPHOSTAGENT<Version>.SAR archive files.

See also section Updating SAP Web Dispatcher in SAP Note 908097 e .

During the installation, you can either specify the path to each archive separately, or provide the path to a
download basket with all downloaded archives.

Caution

e Make sure that you always use the highest available patch level unless special patch levels are specified
for the relevant package in SAP Note 1680045 .

e Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR of the same
SAP kernel release and extension:

Example

o If SAPEXE<Version>.SARis of version 7.42 EXT, then SAPEXEDB<Version>.SAR must also be
of version 7.42 EXT.

o |f SAPEXE<Version>.SARIs of version 7.45, then SAPEXEDB<Version>.SAR must also be of
version 7.45.

e |f you provide the archives in one download folder, and there is more than one version of the same
archive available - for example SAPEXE<Version>.SAR - and these versions match the product-
specific requirements, the installer selects one of these archive versions. If you want a specific archive
version to be used, make sure that this is the only version available in the download folder. When
running system provisioning in GUlI mode, you can also check in the GUI which archive is being used. So
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even if there is more than one version of the same archive available in the download folder, you can
select the exact archive version you want to use and enter the exact path to the required archive file.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading
the Software Provisioning Manager Archive [page 31].
2. Goto http://support.sap.com/swdc# | # Software Downloads » SUPPORT PACKAGES & PATCHES »
By Category 4
3. Download the latest patch level of the following software component archives (*.SAR files) from the
following paths:
o If you want to apply installation option SAP Web Dispatcher (Unicode), download
sapwebdisp <Version>.sar from the following path:
| SAP TECHNOLOGY COMPONENTS » » SAP WEB DISPATCHER » SAP WEB DISPATCHER 7.45 »
<Operating System> 4

o If you want to apply installation option SAP Web Dispatcher (Non-Unicode), download
sapwebdisp<Version>.sar from the following path:

|} SAP TECHNOLOGY COMPONENTS > SAP Web Dispatcher > SAP WEB DISPATCHER <7.21 or
7.42> > <Operating System> }

o If you want to apply installation option SAP WEB DISPATCHER <7.21 or 7.42> with SAP Kernel
7.21., download the latest patch level of SAPCRYPTOLIB <Version>.SAR:

| Additional Components » SAPCRYPTOLIB » COMMONCRYPTOLIB<Version> # <Operating

System> 4
O SAPHOSTAGENT <Version>.SAR:
| SAP Technology Components » SAP HOST AGENT » SAP HOST AGENT 7.21 » <Operating

System> }

3.7.4 Downloading the Complete Installation Media

This section describes how you download complete media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading
the Software Provisioning Manager Archive [page 31].

2. ldentify all download objects that belong to one medium according to one of the following:
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1 Note

Installation media might be split into several files. In this case, you have to reassemble the required files
after the download.

o Download path or location:
You can download installation media from the SAP Software Download Center using one of the
following paths:

o http://support.sap.com/swdc# | Software Downloads # INSTALLATIONS & UPGRADES » By
Alphabetical Index (A-Z) » <First Letter Of Your Product> # <Your Product> ¥

<Your Product Version> b

o http://support.sap.com/swdc# | Software Downloads » INSTALLATIONS & UPGRADES » By
Category » <Your Product> # <Your_ Product Version> §

o For downloading the kernel media, proceed as described in the Kernel Media section of SAP Note
1680045¢% .

o Material number

All download objects that are part of an installation medium have the same material number and an

individual sequence number:

<Material Number> <Sequence Number>

Example
51031387 1

51031387 2

o Title
All objects that are part of an installation medium have the same title, such as
<Solution><Media Name><0S> Or <Database>RDBMS<0S> for database media.
3. Download the objects to the download directory.

4. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.
In the unpacking directory, the system creates a subdirectory with a short text describing the medium and

copies the data into it. The data is now all in the correct directory, the same as on the medium that was
physically produced. For more information, see SAP Note 1258173 .

Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation
media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for
archive-based installation.
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4 Installation

4.1 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer:

® You need at least 300 MB of free space in the installation directory for each installation option. In addition,
you need 300 MB free space for the installer executables.
e Make sure that you have defined the most important SAP system parameters as described in Basic
Installation Parameters [page 18] before you start the installation.
® Make sure that the following ports are not used by other processes:
o Port 21212 is used by default for communication between the installer GUI server and the installer GUI
client.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
following command line parameter:
SAPINST DIALOG_PORT=<Port_Number>
o Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer
processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the

following command line parameter:
SAPINST HTTP_PORT=<Port Number>

4.2 Running the Installer

This section describes how to run the installation tool Software Provisioning Manager 1.0 (the “installer” for
short).

Software Provisioning Manager 1.0 includes a GUI client and a GUI server, which both use Java. In the
following, GUI client and GUI server are called the “installer GUI".

This procedure describes an installation where the installer and the installer GUI are running on the same host.

Prerequisites

For more information, see Prerequisites for Running the Installer [page 36].
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Procedure

1. Logon to the installation host using an account with the required user authorization to run the Installer
[page 23].

Caution

Do not use an existing <sapsid>adm user.

2. Make the installation media available.
For more information, see Preparing the Installation Media [page 30].

3. Start the installer by double-clicking sapinst . exe from the directory to which you unpacked the
Software Provisioning Manager archive.
The installer GUI starts automatically by displaying the Welcome screen.

1 Note

If you need to assign a virtual host name to the instance to be installed and you do not want to assign it
by entering it as a parameter using the installer screens (see Basic Installation Parameters [page 18]),
you can alternatively assign it as follows:

1. Openacommand prompt or PowerShell window in elevated mode and change to the directory to
which you unpacked the Software Provisioning Manager archive.

2. Start the installer with the following command:
sapinst.exe SAPINST USE_HOSTNAME=<Virtual Host Name> (in acommand prompt)
.\sapinst.exe SAPINST USE_HOSTNAME=<Virtual Host Name> (in PowerShell)

For more information, see Using Virtual Host Names [page 29].

4. Onthe Welcome screen, execute the required option:
o Toinstall anew SAP Web Dispatcher instance, choose one of the following:

Table 13:

Option Description

| Generic Options » SAP | Installs a non-Unicode SAP Web Dispatcher instance using SAP WEB DISPATCHER
Web Dispatcher (Non- <7.21 or 7.42>.

Unicode) ]

|F Generic Options ¥ SAP | Installs a Unicode SAP Web Dispatcher instance using SAP WEB DISPATCHER 7.45.
Web Dispatcher

(Unicode) 3

o Torename an existing SAP Web Dispatcher instance, go to System Rename and choose: |# Distributed

System » System Rename for Web Dispatcher Instance 3

o To uninstall an existing SAP Web Dispatcher instance, go to [r Generic Options » <Database>

Uninstall Jand choose:
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5. Choose Next.

6. If the installer prompts you to log off from your system, log off and log on again.
The installer restarts automatically.

7. Follow the instructions on the installer screens and enter the required parameters.

1 Note

To find more information on each parameter during the input phase of the installation, position the
cursor on the required parameter and press .

After you have entered all requested input parameters, the installer displays the Parameter Summary
screen. This screen shows both the parameters that you entered and those that the installer set by
default. If required, you can revise the parameters before starting the installation.

8. To start the installation, choose Start.
The installer starts the installation and displays the progress of the installation. When the installation has
finished, the installer shows the message: Execution of <Option Name> has completed.

9. We recommend deleting all files in the directory $userprofile%\.sdtgui.

10. If you copied the installer software to your hard disk, you can delete these files when the installation has
successfully completed.

4.3 Additional Information About the Installer

The following sections provide additional information about the installer:

e Useful Information About the Installer [page 38]

e How to Avoid Automatic Logoff by the installer [page 39]
e |[nterrupted Installation [page 40]

e Performing a Remote Installation [page 42]

e Starting the Installer GUI Separately [page 44]

® Running the Installer in Accessibility Mode [page 46]

® Troubleshooting with the Installer [page 47]

4.3.1 Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

e The installer creates the installation directory sapinst_instdir, where it keeps its log files, and which is
located directly in the $ProgramFiles% directory. If the installer is not able to create sapinst _instdir
there, it tries to create sapinst instdir inthe directory defined by the environment variable TEMP.

e Foreach option, the installer creates a subdirectory located in the sapinst instdir directory.

e The installer extracts itself to a temporary directory (TEMP, TMP, TMPDIR, Or SystemRoot). These
executables are deleted after the installer has stopped running.

Directories called sapinst exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can
safely delete them.
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The temporary directory also contains the log file dev_selfex.out from the extraction process, which
might be useful if an error occurs.

Caution

If the installer cannot find a temporary directory, the installation terminates with the error FC0-00058.

e Toseealist of all available installer properties, go to the directory $TEMP%\sapinst exe.xXXXXX.XXXX
after you have started the installer, and enter the following command:
sapinst.exe -p

e |fyou need to run the installer in accessibility mode, proceed as described in Running the Installer in
Accessibility Mode [page 46].

e Ifrequired, stop the installer by choosing [# SAPinst j» Exit Process 4 in the installer GUI menu.

1 Note

If you need to terminate the installer, choose || File » Close GUI only 1 in the menu of the Program
Starter window.

e |fyou want to install an SAP system in unattended mode, see SAP Note 2230669#% which describes an
improved procedure using inifile.params.

4.3.2 How to Avoid Automatic Logoff by the Installer

When you install the SAP system, the installation tool checks whether the user account used for the
installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local Administrators group and the
domain Admins group. For alocal installation, the account needs to be a member of the local group
Administrators group.

In both cases, the user account must be authorized to do the following:

e Act as part of the operating system
e Adjust memory quotas for a process
® Replace a process level token

If the user account does not have these rights assigned, the installer assigns them and automatically logs the
account off to activate them. To avoid the installer logging the account off, you can set these rights manually
before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.
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Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain
administrator rights to a user who belongs to the local Administrators group, make sure that you have
also defined domain administrator rights for this user on domain level.

~

Windows Server 2012 (R2): Press + and choose |» Administrative Tools » Local Security
Policy 3.

. Windows Server 2008 (R2): Choose | Start » Control Panel » Administrative Tools # Local Security

Policy 3.

In the Local Security Settings window, choose |F Local Policies » User Rights Assignment. 3.
Double-click the required right under Policy and choose Add User or Group.

In the Select Users and Groups window, choose the required user and choose Add.
The selected user appears in the box below.

Confirm your entry and then repeat the steps for each remaining policy that the user requires for the
installation.

Log off and log on again to apply the changes.

More Information

Required User Authorization for Running the Installer [page 23]

4.3.3 Interrupted Processing of the Installer

The processing of the installer might be interrupted for one of the following reasons:

40

An error occurred during the Define Parameters or Execute phase:

The installer does not abort the installation in error situations. If an error occurs, the installation pauses
and a dialog box appears. The dialog box contains a short description of the choices listed in the table
below as well as a path to a log file that contains detailed information about the error.

You interrupted the installation by choosing Exit Process in the SAPinst menu.

Caution

If you stop an option in the Execute phase, any system or component installed by this option is
incomplete and not ready to be used. Any system or component uninstalled by this option is not
completely uninstalled.
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The following table describes the options in the dialog box:

Table 16:
Option Definition
Retry The installer retries the installation from the point of failure without repeating any of
the previous steps.
This is possible because the installer records the installation progress in the
keydb.xml file.
We recommend that you view the entries in the log files, try to solve the problem,
and then choose Retry.
If the same or a different error occurs, the installer displays the same dialog box
again.
Stop The installer stops the installation, closing the dialog box, the installer GUI, and the
GUlI server.
The installer records the installation progress in the keydb . xm1 file. Therefore, you
can continue the installation from the point of failure without repeating any of the
previous steps. See the procedure below.
Continue The installer continues the installation from the current point.
View Log Access installation log files.
Procedure

This procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to
continue an interrupted installation after an error situation.

1. Logonto theinstallation host as a user with the required permissions as described in Running the Installer
[page 36].

2. Make sure that the installation media are still available on the installation host.
For more information, see Preparing the Installation Media [page 30].

= Recommendation

Make the installation media available locally . For example, if you use remote file shares on other
Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from
media mounted with NFS might fail.

3. Restart the installer by double-clicking sapinst.exe from the directory to which you unpacked the
Software Provisioning Manager archive.

4. From the tree structure on the Welcome screen, select the installation option that you want to continue
and choose Next.
The What do you want to do? screen appears.

5. Onthe What do you want to do? screen, decide between the following alternatives and continue with Next:
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Table 17:

Alternative Behavior

Run a new option The installer does not continue the interrupted installation option. Instead, it
moves the content of the old installation directory and all installation-specific files
to a backup directory. Afterwards, you can no longer continue the old installation
option.

The following naming convention is used for the backup directory:

log <Day> <Month> <Year> <Hours> <Minutes> <Seconds>

Example

log 01 Oct 2008 13 47 56

1 Note

All actions taken by the installation before you stopped it (such as creating di-
rectories or users) are not revoked.

Caution

The installer moves all the files and folders to a new log directory, even if these
files and folders are owned by other users. If there are any processes currently
running on these files and folders, they might no longer function properly.

Continue with the old option The installer continues the interrupted installation from the point of failure.

4.3.4 Performing a Remote Installation

You use this procedure to install your SAP system on a remote host. In this case, the installer runs on the
remote host, and the installer GUI runs on the local host. The local host is the host from which you control the
installation with the installer GUI. The installer GUI connects using a secure SSL connection to the installer.

If your security policy requires that the person performing the installation by running the installer GUI on the
local host is not allowed to know administrator credentials on the remote host, you can specify another
operating system user for authentication purposes. You do this using the SAPINST REMOTE ACCESS USER
parameter when starting sapinst.exe from the command line. You have to confirm that the user is a trusted
one. For more information, see SAP Note 1745524 #r .

Prerequisites

e The remote host meets the prerequisites for starting the installer as described in Prerequisites for
Running the Installer [page 36].

e Both computers are in the same network and can ping each other.
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To test this:
1. Logonto your remote host and enter the command: ping <Local Host>
2. Logonto the local host and enter the command: ping <Remote Host>
e |fyou need to specify another operating system user with the SAPINST REMOTE ACCESS USER
command line parameter, make sure that this user exists on the remote host.

Procedure

1. Logonto your remote host as a user that has the required authorization for running the installer [page
23].

2. Make the installation media available on your remote host.
For more information, see Preparing the Installation Media [page 30].

3. Openacommand prompt and change to the directory to which you unpacked the Software Provisioning
Manager 1.0 archive.

4. Check the version of the sapinst executable by entering the following command:
sapinst.exe -sfxver
The version of the sapinst executable must be exactly the same as the version of the sapinstgui
executable on the local host (see also Starting the Installer GUI Separately [page 447).

5. Start the installer by executing the following command:
sapinst.exe -nogui

1 Note

If you need to specify another operating system user for authentication purposes, enter the following
command:

sapinst.exe -nogui SAPINST REMOTE ACCESS USER=<Specified_ OS User>

1 Note

If you need to assign a virtual host name to the instance to be installed and you do not want to assign it
by entering it as a parameter using the installer screens (see Basic Installation Parameters [page 18]),
you can alternatively assign it as follows:

1. Open acommand prompt or PowerShell window in elevated mode and change to the directory to
which you unpacked the Software Provisioning Manager 1.0 archive.

2. Start the installer with the following command:
sapinst.exe -nogui SAPINST USE_HOSTNAME=<Virtual Host Name> (inacommand
prompt)
.\sapinst.exe -nogui SAPINST USE_HOSTNAME=<Virtual Host Name> (in PowerShell)

For more information, see Using Virtual Host Names [page 29].

The installer now starts and waits for the connection to the installer GUI. You see the following in the
Program Starter window:
guiengine: no GUI connected; waiting for a connection on host <Host Name>, port

<Port Number> to continue with the installation
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6. Start the installer GUI on your local host as described in Starting the Installer GUI Separately [page 441].

4.3.5 Starting the Installer GUI Separately

You use this procedure to start the installer GUI separately.

You might need to start the installer GUI separately in the following cases:

e You closed the installer GUI using |} File ¥ Close GUI only J from the installer menu while the installer is
still running.

® You want to perform a remote installation, where the installer GUI runs on a different host from the
installer. For more information, see Performing a Remote Installation [page 42].

Prerequisites

e The host on which you want to start the installer GUI meets the prerequisites for starting the installer as
described in Prerequisites for Running the Installer [page 36].

1 Note

If you want to run the installer on a UNIX host, make sure that you meet the prerequisites for the
installer listed in the relevant UNIX guide.

Procedure

In this procedure, the following variables are used: <Remote Host> is the name of the remote host, and
<Port Number Gui Server To Gui_Client>isthe portthe GUI server uses to communicate with the GUI
client (21212 by default).

1 Note

If you want to run the installer GUI on a remote host, it is mandatory to start the installer using the -nogui
property. If you have already started the installer without the -nogui property and want to run the GUl on a
different host, you have to exit the installation process by choosing s SAPinst # Exit Process J and then
follow the steps described in Interrupted Installation [page 40]. Use the -nogui property to restart the
installer and start the installer GUI on the intended host.

Starting the Installer GUI on Windows

1. Make the installer software available on the host on which you want to start the installer GUI.
For more information, see Preparing the Installation Media [page 30].
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2. Start the installer GUI by executing the sapinstgui executable with the appropriate command line
parameters:
o If you want to perform a remote installation, proceed as follows:
1. Check the version of sapinstgui .exe by entering the following command:
<Path_To_Unpack Directory>\sapinstgui.exe -sfxver
The version of the sapinstgui executable must be exactly the same as the version of the
sapinst executable on the remote host (see also Performing a Remote Installation [page 42]).
2. Start the installer GUI by entering the following command:
<Path_To_Unpack Directory>\sapinstgui.exe -host <Remote Host> -port
<Port_Number Gui_Server To_ Gui_Client>

o Ifyou closed the installer GUI using |# File » Close GUI only 3 and want to reconnect to the installer,
proceed as follows:
1. If you are performing a local installation with the installer and the installer GUI running on the
same host, execute the following command:
<Path _To_Unpack Directory>\sapinstgui.exe -port
<Port_ Number Gui_Server To_Gui_Client>
2. If you are performing a remote installation with the installer and the installer GUI running on

different hosts, execute the following command:
<Path To Unpack Directory>\sapinstgui.exe -host <Remote Host> -port
<Port Number Gui_Server_To_Gui_Client>

3. Theinstaller GUI starts and connects to the installer.

Starting the Installer GUI on UNIX

1. Make the installer software available on the host on which you want to start the installer GUI.
For more information, see Preparing the Installation Media [page 30].
2. Starttheinstaller GUI by executing the sapinstgui executable with the appropriate command line
parameters:
o If you want to perform a remote installation, proceed as follows:
1. Check the version of the sapinstgui executable by entering the following command:
<Path _To Unpack Directory>/sapinstgui -sfxver
The version of the sapinstgui executable must be exactly the same as the version of the
sapinst executable on the remote host (see also Performing a Remote Installation [page 42]).
2. Start the installer GUI by entering the following command:
<Path_To_Unpack Directory>/sapinstgui -host <Remote Host> -port
<Port_ Number Gui_Server To_ Gui_Client>

o Ifyou closed the installer GUI using |» File » Close GUI only 3 and want to reconnect to the installer,

proceed as follows:

1. If you are performing a local installation with the installer and the installer GUI running on the
same host, execute the following command:
<Path _To Unpack Directory>/sapinstgui -port
<Port_ Number Gui_Server To_Gui_Client>

2. If you are performing a remote installation with the installer and the installer GUI running on
different hosts, execute the following command:
<Path _To_Unpack Directory>/sapinstgui -host <Remote Host> -port
<Port Number Gui_Server_To_Gui_Client>

3. Theinstaller GUI starts and connects to the installer.
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4.3.6 Running the Installer in Accessibility Mode

You can also run the installer in accessibility mode. The following features are available:

e Keyboard access:
This feature is available for all operating systems.

e High-contrast color:
This feature is derived from the Windows display properties. You can use it either for a local installation or
for a remote installation.

e Custom font setting:
This feature is derived from the Windows display properties. You can use it either for a local installation or
for aremote installation.

Procedure

Activating and Adjusting Accessibility Settings on Windows

You first have to activate and adjust the relevant settings for the font size and color schemes before you start
the installer or the installer GUI.

1 Note

The following procedure applies for Windows Server 2008 and might be different when using another
Windows operating system.

1. Right click on your Windows desktop and choose Personalize.

2. Choose Adjust font size (DPI) and choose Larger scale (120 DPI).
To define other font size schemes, choose Custom DPI.

3. Intheright-hand pane, select Window Color and Appearance.
Select a color scheme from the Color scheme dropdown box.
To define your own color schemes, choose Advanced.

Running the Installer in Accessibility Mode

You can either perform a local installation, where the installer and the installer GUI are running on the same
host, or a remote installation, where the installer and the installer GUI are running on different hosts.

® | ocal installation:
Start the installer as described in Running the Installer [page 36] by executing the following command:
sapinst.exe -accessible
e Remote installation:
1. Start the installer on the remote host by executing the following command from the command line as
described in Performing a Remote Installation [page 421:
sapinst.exe -nogui
2. Start the installer GUI on the local host by executing the following command from the command line
as described in Starting the installer GUI Separately for a Remote Installation [page 441]:
sapinstgui.exe -accessible -host <Remote Host> -port
<Port_ Number Gui_Server To_ Gui_Client>
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4.3.7 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

If an error occurs, the installer:

e Stops processing
e Displays a dialog informing you about the error

Procedure

1. Check SAP Note 15484384 for known installer issues.
2. Toview the log file, choose View Logs.
3. Ifanerror occurs during the dialog or processing phase, do one of the following:
o Try to solve the problem.
o Abort the installer by choosing Stop from the error message or | SAPinst # Exit Process 4 in the tool
menu.
For more information, see Interrupted Installation [page 40].
Continue by choosing Retry.
4. Check the log and trace files of the GUI server and the installer GUI in the directory $userprofile%
\.sdtgui)\ forerrors.

o Ifthe GUI server or the installer GUI do not start, check the file sdtstart.err inthe current
Suserprofile% directory.

o Ifthe installer GUI aborts without an error message, restart the installer GUI as described in Starting
the Installer GUI Separately [page 44].
5. If you cannot resolve the problem, report an incident using component BC-INS.
For more information about using subcomponents of BC-INS, see SAP Note 1669327 #r .
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5 Post-Installation Activities

5.1 Logging on to the SAP Web Dispatcher Management
Console

This section describes how to log on to the SAP Web Dispatcher.

Context

You must log on to the SAP Web Dispatcher Management Console to do the following:

e Check whether the SAP Web Dispatcher was installed successfully,
e Change the password of the webadm user,

e Access monitoring and administration tools.

Procedure

1. Openaweb browser.
2. Enter the following URL, depending on whether you use HTTP or HTTPS:

http(s) : //<Webdispatcher Host>:<HTTP(S)_PORT>/sap/wdisp/admin

Example

https://plx282:44300/sap/wdisp/admin

3. Logon as user webadm with the password that you entered during the input phase of the installation.

The SAP Web Dispatcher Monitor screen appears.

4. We recommend that you change the password of webadm immediately after the installation for security
reasons.

For more information, see the Web Dispatcher documentation in the SAP Library [page 11] at:

|+ Application Help » Function-Oriented View » Application Server Infrastructure » Components of SAP
NetWeaver Application Server » SAP Web Dispatcher » Administration of the SAP Web Dispatcher » Using
the Web Administration Interface » Area menu  Section "HTTP Handler” 3
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5.2 SAP Web Dispatcher Configuration

After installing SAP Web Dispatcher, you must configure it to be able to use it.

For more information, see the Web Dispatcher documentation in the SAP Library [page 11] at: | Application
Help » Function-Oriented View ¥ Application Server Infrastructure » Components of SAP NetWeaver
Application Server » SAP Web Dispatcher J
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6 Additional Information

6.1 Using Virtual Host Names

You can use one or more virtual TCP/ 1P host names for SAP servers within an SAP server landscape to hide
their physical network identities from each other. This can be useful when quickly moving SAP servers or
complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

e Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

® Make sure that you configured the Windows operating system properly to use virtual host names. For
more information, see SAP Note 1564275 .

Procedure

To install a non-high-availability system, proceed as described in SAP Note 1564275 ¥ .

6.2 Checking and Changing the Paging File Settings on
Windows Server 2012 (R2)

Use

This section describes how to check and change the paging file size on Windows Server 2012 (R2) with
PowerShell.

The PowerShell commands also work in previous Windows versions where PowerShell is available.

1 Note

Some paging file operations require a reboot of the server to activate the changes you made. Wmi-
commands do not indicate whether a reboot is required or not. Therefore, we recommend rebooting your
system every time you change the paging file settings with PowerShell.
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Prerequisites

Always start the PowerShell in elevated mode (run as administrator).

Procedure

Checking the Size of a Paging File

1. Start Windows PowerShell.
2. Check whether the default value Automatic manage pagefile size for all devices is activated.

1 Note

We do not support automatically managed page file sizes.

To check this, enter the following command:
(Get-WmiObject Win32_ Pagefile) -eq $null
If Automatic manage pagefile size for all devices is enabled, the output value is True.
If necessary, disable Automatic manage pagefile size for all devices with the following command:
$sys = Get-WmiObject Win32 Computersystem -EnableAllPrivileges
$sys.AutomaticManagedPagefile = $false
$sys.put()
3. Check the size of the paging files with the following command:
Get-WmiObject WIN32 Pagefile | Select-Object Name, InitialSize, MaximumSize,
FileSize
The output looks like the following:

Name InitialSize
MaximumSize FileSize

C:\pagefile.sys 0 0
41943040000

E:\pagefile.sys 40000 80000
41943040000

In this example, in the first line, the InitialSize and MaximumSize values of a paging file are O, which means
that the paging file size is system managed (not recommended).
In the second line, the paging file size has a minimum and a maximum size (recommended).

Changing the Size of a Single Paging File

Changing the InitialSize and MaximumSize values of a paging file to a size other than O, will automatically
switch off system managed size.

In the following example, we change the size of the paging file on C: to the InitialSize of 40 GB and to the
MaximumSize of 80 GB.

Use the following commands in a PowerShell:

$Pagefile = Get-WmiObject Win32_ PagefileSetting | Where-Object {$_.name -eq “C:
\pagefile.sys”}
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$Pagefile.InitialSize = 40000

$Pagefile.MaximumSize 80000
$Pagefile.put()

Typically, you choose the same value for InitialSize and MaximumSize.

1 Note
The sum of all paging files InitialSize values must be equal to or higher than the value recommended for
your SAP system.
Creating a Second Paging File on Another Disk

You might want to create a second or additional paging files to improve system performance, or if your disk
does not have enough space.

To do so, enter the following commands in a PowerShell:
$Pagefile = Get-WmiObject Win32_PagefileSetting
$pagefile.Name = “E:\pagefile.sys”
$pagefile.Caption = “E:\pagefile.sys”
$pagefile.Description = “/'pagefile.sys’ Q@ E:\”
$pagefile.SettingID ="pagefile.sys Q@ E:”
$pagefile.InitialSize = 80000
$pagefile.MaximumSize = 80000

$pagefile.put()

Deleting a Paging File on a Specific Device

To delete a paging file, enter the following commands in a PowerShell:

Spagefile = Get-WmiObject Win32_ PagefileSetting | Where-Object {$_.name -eq “E:
\pagefile.sys”}

Spagefile.delete ()

6.3 Starting and Stopping with the SAP Microsoft
Management Console (SAP MMC)

Use

You have to check that you can start and stop the Web Dispatcher after the installation using the SAP
Microsoft Management Console (SAP MMC).
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You can start and stop the instance by using the SAP MMC in one of the following ways:

e By using the SAP MMC that was installed by the installer automatically on the host of the Web Dispatcher.

e By using the SAP MMC on another host of your existing SAP system landscape, If the SAP MMC is
configured for central system administration.

Procedure

1. Logonasuser <sapsid>adm.

2. Start the SAP MMC by choosing | Start » All Programs % SAP Management Console 3.
3. Right-click the icon of the Web Dispatcher instance under the SAP systems node and choose Start or Stop.

More Information

For more information, see the SAP Library [page 11] at:

e SAP systems based on SAP NetWeaver for Banking Services from SAP:
| Function-Oriented View ¥ Application Server ABAP » Administration Tools for AS ABAP ¥ Monitoring in
the CCMS » SAP Microsoft Management Console: Windows 3

e SAP systems based on SAP NetWeaver Mobile 7.1 / 7.1 including enhancement package 1:
| Function-Oriented View ¥ Application Server ABAP » Administration Tools for AS ABAP ¥ Monitoring in
the CCMS » SAP Microsoft Management Console: Windows 3

e SAP systems based on SAP NetWeaver Process Integration 7.1 / 7.1 including enhancement package 1:
| Function-Oriented View » ABAP Technology / Application Server ABAP j» Administration Tools for AS
ABAP » Monitoring in the CCMS » SAP Microsoft Management Console: Windows 3

® SAP systems based on SAP NetWeaver 7.3 and higher:
| Solution Life Cycle Management # Solution Monitoring # Monitoring in the CCMS » SAP Microsoft

Management Console: Windows 3

6.4 Uninstall

Use

The following procedure describes how to uninstall a Web Dispatcher using the installer.
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Procedure

1. Start the Installer [page 36].

2. Onthe Welcome screen, choose |» Generic Installation Options ¥ <Database> ¥ Uninstall ¥ Uninstall SAP

Systems or Single Instances
3. Follow the instructions in the installer screens.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be
a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however,
does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations
of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as
"sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun
does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does
not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any
damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for
transparency (see: http://help.sap.com/disclaimer).

Open Source Software and Third Party Components

Please refer to https://scn.sap.com/docs/DOC-42044 for information respecting open source software components made available by SAP as part of SAP
NetWeaver and any specific conditions that apply to your use of such open source software components. Please refer to https://scn.sap.com/docs/DOC-42045 for
information relating to SAP’s use of third party software with or within SAP NetWeaver.
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No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
or an SAP affiliate company. The information contained herein may
be changed without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software
vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
are those that are set forth in the express warranty statements
accompanying such products and services, if any. Nothing herein
should be construed as constituting an additional warranty.

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. All other product and service names mentioned are the
trademarks of their respective companies.

Please see http://www.sap.com/corporate-en/legal/copyright/
index.epx for additional trademark information and notices.



https://go.sap.com/registration/contact.html
https://go.sap.com/registration/contact.html
http://www.sap.com/corporate-en/legal/copyright/index.epx
http://www.sap.com/corporate-en/legal/copyright/index.epx

	Installation of SAP Web Dispatcher for SAP Systems Based on SAP NetWeaver 7.0 to 7.5 on Windows
	Content
	Document History
	1 Introduction
	1.1 About this Document
	1.2 About Software Provisioning Manager
	1.3 New Features
	1.4 Architecture and Functions of the SAP Web Dispatcher
	1.5 SAP Notes for the Installation
	1.6 Accessing the SAP Library
	1.7 Naming Conventions

	2 Planning
	2.1 Hardware and Software Requirements
	2.1.1 Hardware and Software Requirements Tables

	2.2 Basic Installation Parameters

	3 Preparation
	3.1 Checking the Windows File System
	3.2 Reducing the Size of the File Cache
	3.3 Required User Authorization for Running the Installer
	3.4 Performing a Domain Installation Without Being a Domain Administrator
	3.5 SAP Directories
	3.6 Using Virtual Host Names
	3.7 Preparing the Installation Media
	3.7.1 Downloading the Software Provisioning Manager Archive
	3.7.2 Using the Physical Media from the Installation Package
	3.7.3 Downloading Specific Installation Archives (Archive-Based Installation)
	3.7.4 Downloading the Complete Installation Media


	4 Installation
	4.1 Prerequisites for Running the Installer
	4.2 Running the Installer
	4.3 Additional Information About the Installer
	4.3.1 Useful Information About the Installer
	4.3.2 How to Avoid Automatic Logoff by the Installer
	4.3.3 Interrupted Processing of the Installer
	4.3.4 Performing a Remote Installation
	4.3.5 Starting the Installer GUI Separately
	4.3.6 Running the Installer in Accessibility Mode
	4.3.7 Troubleshooting with the Installer


	5 Post-Installation Activities
	5.1 Logging on to the SAP Web Dispatcher Management Console
	5.2 SAP Web Dispatcher Configuration

	6 Additional Information
	6.1 Using Virtual Host Names
	6.2 Checking and Changing the Paging File Settings on Windows Server 2012 (R2)
	6.3 Starting and Stopping with the SAP Microsoft Management Console (SAP MMC)
	6.4 Uninstall

	Important Disclaimers and Legal Information
	Copyright / Legal Notice


